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Installation Instructions

Gammill is pleased to announce CreativeStudio® Version 7.0 which is available at 
www.gammill.com/creativestudio7 

This version is for Windows 7 or 8 or 8.1 computers only, Ethernet controllers (Mod A & Up) only. 

CreativeStudio®  Installation Instructions: 

• Download CreativeStudio_7.0.1_Installer.exe (As needed: copy this file to your flash drive move this to 
your desired PC, copy this file to the PC, then eject your flash drive)

• There is now no need to uninstall your old version of CreativeStudio
• Run the Installer file and follow the onscreen directions
• Start CreativeStudio® and notice the introductory splash screen now indicates Version 7.0.1
• Be sure to select your Controller (MOD) Type
• Under the Tools menu item, select “Controller Definition” and set your user defaults, such as SPI, etc.
• If after install on stitcher it shows machine disconnected: Go to Service/Technical Support, click on 

Connect Stitcher. It should then say connected in the lower left of the screen. Close CS7 and reopen.
• You are now ready to run CreativeStudio®, Happy Quilting ☺

http://www.gammill.com/creativestudio7


What’s New 
 
New Pattern Management 
Now all the patterns stored on your computer are shown in the Patterns tab. The patterns are now 
shown as much larger tiles. To use: Click the ‘Patterns’ tab on the left side of the screen, by default all 
patterns are shown. 
 
New Pattern Database 
Now all the patterns on your local computer are stored in a searchable database.  This database can also 
be synced to the cloud for backup purposes. To use: If you want to sync your database data with 
Gammill’s servers, first login by clicking the ‘avatar’ icon in the ‘Patterns’ tab. Once logged in this icon 
will become a ‘cloud’ icon. The sync operation will copy your patterns and tags to Gammill’s database 
and optionally retrieve tags from the global quilting community. 
 
New Pattern Search 
Now you can quickly find a specific pattern. To use: While in the pattern tab, at the top, type in your 
desired search criteria. The search can be constrained by changing the search term in the light grey drop 
down. 
 
New Advanced Pattern Search 
Now you can quickly find a specific pattern by using multiple search criteria. To use: While in the pattern 
tab select ‘Advanced Search.’ Patterns can be searched by tag, also with Boolean operators (And, Or, 
Not). They can also be searched by type (E2E, P2P, etc.), Author and Collection. 
 
New Store tab 
Now you can quickly search the Cloud for patterns that meet your quilting needs. To use: If your PC is on 
the web, click the store tab, type your desire search term and CS will search the Gammill database for 
patterns that match your search criteria. If desired you can purchase those patterns for your own 
personal use and they will automatically be added to your local database. 
 
New tabs minimized or expanded 
Now you can improve your Quilt Group tab viewable area by minimizing your Pattern tabs. Or, you can 
expand your tabs to better view your patterns. To use: To minimize click the left arrow icon in the tab area. 
To maximize click the right arrow icon. 
 
New customizable pattern tiles 
Now the pattern tiles in the Pattern Management tab, Store tab, or Project tab can be set to small, 
medium or large. Tiles can be arranged Alphabetically, by Newest First or by Show Favorites First. Tiles 
can be visually changed by showing Name, Start/End, or Jumps. To use: While in the Pattern tab click the 
gear icon. To change size pick Small, Medium, or Large. Click ‘Show Pattern Name’ to show the name at 
the bottom of the tile. Click ‘Show Start/End’ to show a green mark by the start of the pattern and a red 
mark by the end of the pattern, if the start and end are in the same place the mark will be red and green. 
Click ‘Show Jumps’ to show jump stitches in the pattern with a blue mark. 
 
 



 
New Pattern Tile right click menu 
From a pattern tile you can right click and pop up a menu, in which you can ‘Add to Project,’  ‘Add to 
Favorites,’ ‘View Tags,’ ‘View Properties,’ ‘Export Pattern,’ ‘Sync: Backup to Cloud,’ ‘Sync: Restore from 
Cloud,’ and ‘Delete Pattern.’ To use: In the Patterns or Project tab right click the tile to see the options. In 
the Project tab there is an additional option of ‘Duplicate Pattern.’ 
 
New Manage Collection 
List patterns by collection. To use: Click ‘Manage Collection’ under the ‘Gear’ icon. All collections will be 
shown; if you click a collection then all patterns in that collection will be shown. You can delete the 
collection by clicking the ‘X’ by the collection name.  
 
New Pattern info 
Now no matter where a pattern is, its info can be accessed by right clicking and picking ‘View 
Properties.’ On the Quilt Group tab screen this can also be retrieved by clicking the ‘i’ icon. To use: While 
in a tab right click the pattern tile and select ‘View Properties.’ While on the Quilt Group tab, right click 
the pattern and select ‘View Properties’ or left click a pattern and click ‘p’ on the keyboard. Also a 
simplified pattern properties automatically shows when a pattern is selected in a Quilt Group tab. 
 
New Pattern Import 
Now you can point CS to any pattern folder, adding those patterns to your database. To use: While in the 
Pattern tab click the ‘Paper’ icon and select ‘Import Patterns.’ Point to a folder or a drive location. If you 
would like, you can change the Author, Collection and tag. You can deselect patterns as desired. 
 
New Import Patterns from iPatternStudio or PVM 
If you are a user of iPatternStudio or PVM you can import the tagging and categorizing work that you 
have done. To use: While in the Pattern tab click the ‘paper’ icon and select ‘Import iPatternStudio’ or 
click ‘Import PVM.’ With iPatternStudio simply click ‘Import iPatternStudio’ and point to your database. 
With PVM, first you need to use PVM to export your patterns into a folder and then use CS’s ‘Import 
Pattern’ to add those patterns to the CS database, next select ‘Import PVM Database’ to import your 
custom PVM tags, collections, etc.  NOTE: Due to a Known Issue iPatternStudio import is not useable in 
this version. 
 
New auto add Patterns from USB stick or CD 
Quickly add patterns to your database with this new auto pattern detection routine. To use: While CS is 
running, insert a USB or CD with patterns. CS will prompt and if you want to search the device for 
patterns, just click yes. Next, follow the directions for Pattern Import. 
 
New Pattern drag onto Quilt Group tab 
Quickly place a pattern in your quilt group by dragging it from the Pattern Management tab, the Store 
tab, or the Project tab. Auto makes a copy in the Project tab if drug from the Pattern or Store tab. To use: 
Click and hold the desired pattern with the mouse, drag the pattern onto the Quilt Group tab screen, let 
go of the mouse to place the pattern. 
 
 
 



New pattern hot keys 
A pattern can now be quickly flipped horizontal, flipped vertical or rotated at any degree increment.  To 
use: While dragging the pattern on the keyboard press ‘X’ to flip horizontally, press ‘Y’ to flip vertically, 
press ‘Space’ to rotate the pattern. The same keys used on a selected pattern in the Quilt Group tab will 
manipulate the pattern. The rotation amount is set by right clicking the pattern and setting pattern 
rotation angle. 
 
New Repeat Patterns support in SAM 
Now Patterns can be placed in SAM relative to any click. To use: While in Repeat Patterns setup mouse 
click your reference point anywhere on the Quilt Group tab screen.  You can use grid or endpoint snap for 
these clicks. 
 
New Repeat Patterns Setup form 
Patterns can be dynamically changed and critical properties field can now be locked. To use: Click the 
‘Repeat Patterns’ icon, click your reference point with the mouse or the Stitcher. Next set your Pattern 
Size, Repeats and Rows, Total Size and Spacing. By default Total Size is locked to maintain the value the 
user enters. If desired the lock in Repeats and Rows can be selected instead. 
 
New Edge to Edge support in SAM 
Now all the points can be entered while in SAM with the mouse. While connected to the Stitcher, points 
can be clicked with both the mouse and the head. To use: While in E2E setup click the four corners on the 
Quilt Group tab screen with the mouse. You can use grid or endpoint snap for these clicks. Note: Clicking 
all four points with the mouse is for training and is not practical for use on an actual quilt. Making the 
four points square and a reasonable width and height is recommended. 
 
New Edge to Edge Setup form 
The form now guides you how to proceed by showing an image of where the user is supposed to click. 
The form is not enabled till the user has entered the basic points and necessary information. To use: 
Click the ‘Edge to Edge’ icon, follow the image and words for where to click your points with either the 
Stitcher or the mouse. Next you must enter the ‘Quilt Length.’ Finally, change your parameters as 
desired. 
 
New Border Corner support in SAM 
Now all the points can be entered while in SAM with the mouse. While connected to the Stitcher points 
can be clicked with both the mouse and the head To use: While in BC setup click the four corners on the 
Quilt Group tab screen with the mouse. You can use grid or endpoint snap for these clicks. Note: this is 
for training and is not practical for use on an actual quilt.  Making the points square and a reasonable 
width, height with a consistent border size is recommended. 
 
New Border Corner Setup form 
The form now guides you how to proceed by showing an image of where the user is supposed to click. 
The form is not enabled till the user has entered the basic points and necessary information. To use: 
Click the ‘Border Corner’ icon (if you are setting up the bottom of your border then be sure to check the 
word ‘Bottom’). Follow the image and words for where to click your points with either the Stitcher or the 
mouse. Next you must enter the ‘Quilt Length’. Finally change your parameters as desired. 
 



New Mini Wizard will give help in each section 
Now in each setup field is a “?” that contains help for that specific item. To use: Start any setup, as 
desired click the “?” icon at the top of any section and a small help field will show. 
 
New Build Pattern Catalog feature 
Now you can make your own custom pattern catalog.  You can make a catalog of your search in the 
Pattern tab or the patterns in your Project tab. The result can be saved as a PDF document, an Excel 
spreadsheet, or a Word document. To use: While in Pattern or Project tab click ‘Build Pattern Catalog’ 
under the paper icon drop down. This will make a catalog of all patterns in that tab. If desired click ‘Print’ 
or click ‘Save’ then pick either ‘Excel,’ ‘PDF,’ or ‘Word.’  Then, pick a location for the file. Note: In the 
Pattern tab the catalog is limited to 100 patterns, if you want all your patterns save each group of 100 as 
a word document then place together in one document. 
 
New Cursive Font sews continuous letters 
Now you can create single line cursive, continuous sewable text. To use: Click Text icon or right click the 
open Quilt Group tab and pick Text, mouse click a point, type your phrase, pick Cursive, choose your font, 
and choose the font style.  Note: to add a Cursive font in the Patterns tab click the ‘Paper’ icon then select 
‘Import Font Group.’  Only fonts specifically designed for this new feature will work. 
 
New Text to Boundary, Point or Apply 
Now text will auto fit into a boundary, go to a point, or apply along a pattern. To use: While in Text setup 
click a boundary or clicks an empty point on the Quilt Group tab. It is best if applying text along a pattern 
for the pattern to be simple. 
 
New Universal pattern anchor: Edge, Center and Stretch 
Now you no longer have to cycle thru the pattern anchors to make custom pattern changes. To use: Click 
the Pattern Anchor icon and cycle thru different anchors the new Universal Anchor is made up of three 
anchors. Stretch Anchors are grey, Center Anchors are Orange, Edge Anchors are Blue. 
 
New Nudge anchors with arrow keys 
Now pattern anchors can be moved precisely. To use: Click an anchor handle (it will change color when 
selected), while holding the mouse key down click the keyboard arrow keys. 
 
New inset Apply patterns supported 
Now patterns with a tucked in Start or End work for Apply Pattern. 
 
New Stitcher and Mouse functions consolidated 
Now Head only and Quilt Group tab only functions are one icon. For example, instead of P2P Line for the 
Stitcher and Draw Line for the mouse we now just have ‘Draw Line.’ Depending on where the input 
comes from is where the XY information is pulled from. It is possible to click ‘Draw Line’ then click all 
mouse points, OR all Stitcher points, OR go back and forth. To use: Click any drawing function then use 
the head and or the mouse to click your points. 
 
 
 
 



New Snap goes to both Endpoint and Grid point snap 
Now you just need to turn snap on and when you are close to an Endpoint your drawing will snap to 
that. And, when close to a Grid point it will snap to that. To use: In the Status Strip pick the triangle next 
to snap, from the flyup options select both ‘End’ and ‘Grid’ (or click G or E on the keyboard). Click ‘Snap 
On’ in the lower Status Strip Bar (or click S on the keyboard). As you move your mouse close to a Grid or 
End Point the cursor will jump, and show a pink dot. Note: The snapping noise was removed to speed the 
snap process. 
 
New Speed, SPI interface 
Now there is more interactive information on the Status Strip. To use: While stitching, Speed and SPI can 
be dynamically changed by clicking the + or -. Also, you can type directly in the text field. The word 
‘Speed’ will turn purple when it has been changed. To revert click the word ‘Speed.’ 
 
New Zoom 
New modified Zoom features.  To use: Use the mouse scroll wheel to get the grid to the size you desire, it 
may be good to hold a ruler to the screen to help with this sizing. Next, click the triangle button next to 
the ‘Zoom’ text, select ‘Set current Zoom as 100%.’  In the same flyout click ‘Zoom to 100%’ to quickly 
return to your custom 100% or click the word ‘Zoom.’ 
 
New Grid value on status strip 
Now the Grid sizing is easily viewed and changed in the lower Status Strip. 
 
New XY position on status strip 
In the upper left corner of the Quilt Group is continually updated with X & Y locations. 
 
New moveable and collapsible Keypad 
To use: Click, hold and drag the keypad to your desired location. Clicking the down arrow will collapse the 
keypad to the Status Strip. 
 
New Anytime Chanel Lock 
Now that you will be able to draw a Line outside of the P2P Line (where the Channel Lock resides) and 
now that we are no longer calling that specialized form, we added channel lock to the Main form so it 
can be activated any time CS is idle.  This is necessary for the consolidation of Quilt Group tab and 
Stitcher but it has also been a very common user enhancement request. To use: In the lower right corner 
change the angle and click the ‘C-Lock’ icon. 
 
New items were moved to the top menu bar 
Now almost every Quilt Group tab menu item is available in the menu bar. 
 
New items were moved to the toolstrip bar 
Now almost every tool strip item including those previously only available in the right click menu are 
now available in the toolstrip. 
 
 
 
 



New Print function 
Now you can print your current Quilt Group setup. To use: Zoom your Quilt Group tab screen so the area 
you want so it is taking up the entire view. Then click the print icon. You will see a preview before you 
print.  Note: It is not advisable to use the installation disk that comes with the printer, instead try 
allowing Windows to find the driver. 
 
New Copy, Cut, and Paste Function 
Allow copying patterns between Quilt Groups, between Projects, and even after restarting CS. To use: 
Select a pattern in the Quilt Group. Then, in the menu strip select the Copy icon to retain the original or 
select the Cut icon to delete the original pattern. Clicking the Paste icon will make the pattern free float 
with your cursor, every click will place a pattern. Also available under the ‘Edit’ menu item, the Quilt 
Group right click a pattern menu, and the keyboard shortcuts of Ctrl+C, Ctrl+X and Ctrl+P. 
 
New Rubberstamp 
Now rubber stamp is more dynamic, repetitive and controllable. To use: right click your desired pattern 
then click ‘Rubber Stamp’ or select the Rubber Stamp toolstrip icon. The pattern now becomes attached to 
your cursor; every click will place a pattern. 
 
New user settable Menu strip 
Now the Menu strip icons can be completely customized. To use: Right click the Menu or Tool strip,, Pick 
‘Customize Menu’, the order can be changed by dragging icons up or down, or by dragging from the left 
unused icons to the right used icons. There is an up down click icon to more conveniently move icons up 
and down. There are many preset options like CS6 and CS7 layouts. There also a ‘Save Layout’ that lets 
you save custom menu layouts. 
 
New user settable Tool strip 
Now the Tool strip icons can be completely customized. To use: Right click the Menu or Tool strip, Pick 
‘Customize Toolstrip’, the order can be changed by dragging icons up or down, or by dragging from the 
left unused icons to the right used icons. There is an up down click icon to more conveniently move icons 
up and down. There are many preset options like CS6 and CS7 layouts. There also a ‘Save Layout’ that 
lets you save custom toolstrip layouts. 
 
New Text Setup form 
Now Block text or new Cursive text have a common setup.  Also Text Setup no longer uses the Standard 
Windows font dialog, all changes can be done in one place. To use: Click the Text icon or in the right click 
menu pick ‘Draw Text’. The top indicates how the text will be placed, either at a clicked point, along a 
pattern or in a boundary. Next in the ‘Enter Text’ field type your text. Now customize your ‘Font 
Parameters’. 
 
New Echo Setup form 
Echo is now dynamically changeable. You can change the count, the spacing, the pattern selected or 
echo inside or outside. Echo can now also be done on trims and boundaries. To use: Select the ‘Echo 
Object’ icon, then select any Quilt Group object, if you picked the wrong one that is ok just click a 
different object and the echo will automatically move to your selected object. Next ‘Set Parameters’ of 
Spacing and your desired ‘Number’ of echoes. You can also change the echoes from the default of 



‘Outside’ to ‘Inside’, but note that the center of an inside echo is determined by where you click with your 
mouse. 
 
New Circular Array Setup form 
In Circular Array the center can now be dragged, the count or degrees can be changed, and the patterns 
can be connected to sew continuously. To use: Place a pattern on the Quilt Group tab, click the ‘Circular 
Array’ icon, and next change the ‘Count’ or the ‘Degrees’. If possible the patterns will attempt to arrange 
themselves to sew continuously. Uncheck ‘Connect’ if you don’t want the patterns to connect. Drag the 
blue center icon to change the center of the Circular Array; this is most dynamic if ‘Connect’ is 
unchecked.  Note: it is now not possible to control the center position, instead setup up your desired 
array, then move your patterns. 
 
New all setups are dynamic 
Any change in the setup fields takes immediate effect on the Quilt Group tab screen. The dynamic 
patterns are drawn dashed Black and Yellow. 
 
New Dynamic Pattern setup update 
While in setup mode a pattern change in the Project tab will dynamically change the pattern drawn on 
the Quilt Group tab screen. 
 
New images to help Border Corner and Edge to Edge setup 
Added images to Border Corner and Edge to Edge setups, shows a moving star for the corner to click, for 
example, Upper Left Outer Corner, etc. 
 
New ‘OK,’ ‘AGAIN,’ and ‘CANCEL’ options at the top and bottom of all Setups 
Now setups can be confirmed by clicking ‘OK’ and a good setup can be repeated by clicking ‘AGAIN.’ A 
botched setup can be quit and all changes on the Quilt Group tab will go away by clicking ‘CANCEL.’ 
 
New selected Boundary color is now dashed blue 
Now boundaries are more easily distinguishable from patterns. 
 
New selected Trim color is now dash dot gold 
Now Trims are easier to distinguish. 
 
New Fill auto toggles patterns unsewn 
Now, as needed, the pattern being filled will be auto toggled unsewn. 
 
New drop down to control Auto View All 
Now auto zoom can be turned off. To use: Under the toolstrip ‘View All’ icon if ‘Auto View All’ is unchecked 
then CS will not change the view even if the drawing goes off the screen. This is most useful for pattern 
designing where it is desirable to keep the view stationary. 
 
New toolstrip 
Now the toolstrip is taller and contains many more items and new custom designed icons. 
 



New showing Red key in SAM mode Help About 
Now if the red key is inserted and the Stitcher is off or not present the Red Key shows. 
 
New Apply works on patterns with No Sew jumps 
Now patterns that contain a no sew jump work in Apply Patterns. 
 
New Polyline to Arc conversion feature 
As much as possible changes a polyline to arcs. If you look at the pattern with the Nodes feature before 
and after you can observe the effect. To use: Right click the desired pattern, pick ‘Convert,’ and then 
‘Points to Arc.’ 
 
New Alt Arrow click is a 10 times finer move 
Now the keyboard movement of patterns is 10 times finer. To use: Pick a pattern, hold the ‘Alt’ key down 
then use the four arrow keys and watch the pattern move. To move more coarsely hold ‘Crtl’ instead. 
 
New Pattern and Boundary default line now thicker 
Now the default line is thicker by default. To use: Right click the open Quilt Group tab and pick ‘Image 
Attributes.’ 
 
New Add Quilt Group in tabs 
Now adding quilt group tabs is in a more intuitive location. To use: Click the tab with the ‘Green Plus’ 
icon; a Quilt Group will be automatically named and added. 
 
New Delete Quilt Group at top of tab 
Now when you click a Quilt Group a red X will show in the upper right corner of the tab. To use: Click a 
Quilt Group tab, click the red X, and confirm your desire to delete the tab. 
 
New Rename Quilt Group in tab 
Now a Quilt Group can be renamed in the tab itself. To use: Double click the tab and a blue edit box will 
show. Change the name as desired click enter when done 
 
New Main Form is now resizable 
The Main Form is now resizable. To use: Click the Restore Down button in the upper right corner, then 
move the mouse over any corner. When the cursor changes to a diagonal arrow hold the left mouse 
button down. Now move the mouse till CreativeStudio is your desired size. 
 
New click ‘i’ to get to pattern information 
Now pattern information is stored right next to the pattern. To use: Click the any pattern, pick the ‘i’ icon 
in the pattern’s lower left corner. A new form will come up with all the pattern’s properties. The 
properties are changeable as desired. 
 
New click 'x’ to delete pattern 
Now click ‘x’ to delete a pattern. To use: Click the pattern you wish to delete, now click the ‘x’ icon 
located in the patterns upper right corner. 
 



New Freehand Draw started with left click, stopped right click 
Now freehand draw is available from the Head or the Mouse.  Whichever starts the operation is in 
control; you can’t move back and forth like the other Draw functions. 
 
New dynamic Quilt Group tab Measure feature 
Measure anything with the Stitcher or the mouse. To use: click the ‘Measure Tape’ icon then click points 
on your Quilt Group tab screen.  Note the new pink line and the dynamic numeric readout in the lower 
right corner. 
 
New all messages show in the bottom left corner of CS 
Now all messages show in a consistent lower left location. 
 
New toggling icons 
Now when your mouse passes over a toolstrip or menu icon its state changes. Icons that have an on and 
off state will change images to indicate they are on or off. From the Stitcher clicking the ‘Mode’ button 
will cause a much large icon 
 
New Orient Baseline drop down item 
When checked pattern go into the boundary at the angle of the first two clicks. When unchecked 
patterns go in to boundary at a zero based angle. To use: Click the Drop down next to the ‘Pattern to 
Boundary’ icon, then check or uncheck ‘Orient Baseline’ as desired. Note: This only effects Standard 
pattern to boundary, not Stretch. 
 
New pattern extension type GQP 
To replace the CSQ. To use: Right click a pattern and pick ‘Save Pattern’ set to go to Database, Project 
and or file. Set the pattern name and the author.  If the original pattern was encrypted then the pattern 
extension is GQPX. 
 
New Installer is no longer a Zip file 
Now CreativeStudio installer is an EXE. 
 
 
Improvements: 
 
New reversed the color of Diagnostic button presses to match Advanced Diagnostics 
Now the button status color matches the Advanced Diagnostic and other Support tools. 
 
Fixed Magnet window test 
Part of the Technical Support, Test System. 
 
Fixed errant duplicate p2p point message 
No longer gives duplicated point message. 
 
Improved Anchor placement accuracy 
In the last version anchors were not exactly on the pattern perimeter and that is now fixed. 



 
Added Long Run message, progress bar and Escape to Order Join 
It was not too often that Order Join would take a long time. However, if for some reason it did it now 
can be stopped. 
 
Fixed Mirror rotation properties angle 
Pattern properties are now correct with the mirrored angle. 
 
Fixed Designer SPI and SPEED to work in Needle Off mode 
Fixes Known Issues 6.1 & 6.2 
 
Fixed issue with false Antivirus positive 
Some antivirus and IE falsely labeled a third party file as a potential threat, that third party file has been 
updated and replaced. 
 
Added warning messages to CS log 
To help support the log now includes the warning text and the # of the warning. 
 
Fixed issue with small Apply patterns 
Now very small patterns can be applied. 
 
Improved wait cursor 
The wait cursor is more consistent. 
 
Clicking out of boundary or trim will now deselect 
Previously it was not possible to deselect a Boundary or a Trim. 
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